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Copyright 
 
© Copyright 2008, Welch Allyn . All rights are reserved. No one is permitted to translate, 
reproduce or duplicate this manual or any part thereof, in any form, without prior written 
permission from Welch Allyn. Welch Allyn assumes no responsibility for any injury to 
anyone, or for any illegal or improper use of the product, that may result from failure to use 
this product in accordance with the instructions, cautions, warnings, or statement of 
intended use published in this manual.  Unauthorized copying of this publication may not 
only infringe copyright but also reduce the ability of Welch Allyn  to provide accurate and 
up-to-date information to users and operators alike. 
 
Welch Allyn®, CardioPerfect® Workstation and SpiroPerfect® are registered trademarks of 
Welch Allyn.  
 
Software in this product is Copyright 2008, Welch Allyn . All rights are reserved. The 
software is protected by United States of America copyright laws and international treaty 
provisions applicable worldwide.  Under such laws, the licensee is entitled to use the copy 
of the software provided on the original distribution medium. The software may not be 
copied, decompiled, reverse-engineered, disassembled or otherwise reduced to human-
perceivable form. This is not a sale of the software or any copy of the software; all right, title 
and ownership of the software remains with Welch Allyn.  
 
The information contained in this manual is subject to change without notice.  
All changes will be in compliance with regulations governing manufacture of medical 
equipment. 
 
 
 
User responsibility 
This product is designed to perform in conformity with the description thereof contained in 
this manual and accompanying labels and inserts, when assembled, operated, maintained 
and repaired in accordance with the instructions provided. A defective product should not 
be used. Parts that are broken, plainly worn, missing or incomplete, distorted or 
contaminated should be replaced immediately. Should any repair or replacement become 
necessary, we recommend that service be performed at the nearest approved service 
center. The user of the product shall have the sole responsibility for any malfunction, which 
results from improper use, faulty maintenance, improper repair, damage or alteration by 
anyone other than Welch Allyn  or their authorized service personnel. 
 
 
Accessories 
The Welch Allyn  warranty can only be honored if you use Welch Allyn  approved 
accessories and replacement parts. 
 

 

Caution  Use of accessories other than those recommended by Welch Allyn  may 
compromise product performance. 
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Warranty, Service, and Spare Parts 

Warranty 
All repairs on products under warranty must be performed or approved by Welch Allyn. 
Unauthorized repairs will void the warranty. In addition, whether or not covered under 
warranty, any product repair shall exclusively be performed by Welch Allyn certified service 
personnel. 
Assistance and Parts 
If the product fails to function properly or if assistance, service, or spare parts are required, 
contact the nearest Welch Allyn Technical Support Center.  
 
USA 1-800-535-6663 Canada 1-800-561-8797 
Latin America (+1) 305-669-9591 South Africa (+27) 11-777-7509 
European Call 
Center 

(+353) 469-067-790 Australia (+61) 2-9638-3000 

United Kingdom (+44) 207-365-6780 Singapore (+65) 6291-0882 
France (+33) 1-60-09-33-66 Japan (+81) 3-5212-7391 
Germany (+49) 7477-927-173 China (+86) 21-6327-9631 
 
Before contacting Welch Allyn it is helpful to attempt to duplicate the problem and to check 
all accessories to ensure that they are not the cause of the problem. 
 
When calling, please be prepared to provide: 
• Product name and model number and complete description of the problem 
• The serial number of your product (if applicable) 
• The complete name, address and phone number of your facility 
• For out-of-warranty repairs or spare parts orders, a purchase order (or credit card) 

number   
• For parts order, the required spare or replacement part number(s) 
 
Repairs 
If your product requires warranty, extended warranty, or non-warranty repair service, please 
call first the nearest Welch Allyn Technical Support Center. A representative will assist you 
troubleshooting the problem and will make every effort to solve it over the phone, avoiding 
potential unnecessary return.  
 
In case the return cannot be avoided, the representative will record all necessary 
information and will provide a Return Material Authorization (RMA) number, as well as the 
appropriate return address. A Return Material Authorization (RMA) number must be 
obtained prior to any return. 
 Note Welch Allyn does not accept returned products without an RMA. 
 
Packing Instructions 
If you have to return goods for service, follow these recommended packing instructions: 
• Remove all hoses, cables, sensors, power cords, and ancillary products (as 

appropriate) before packing, unless you suspect they are associated with the problem. 
• Wherever possible use the original shipping carton and packing materials. 
• Include a packing list and the Welch Allyn Return Material Authorization (RMA) number. 
 
It is recommended that all returned goods be insured. Claims for loss or damage to the 
product must be initiated by the sender. 
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Limited Warranty Statement 
Welch Allyn, Inc. warrants that the Welch Allyn CardioPerfect Workstation computer based 
product you have purchased meets the labeled specifications of the Product and will be free 
from defects in materials and workmanship that occur within 1 year after the date of 
purchase. Accessories used with the Product are warranted for 90 days after the date of 
purchase.  
 
The date of purchase is: 1) the date specified in our records, if you purchased the Product 
directly from us, 2) the date specified in the warranty registration card that we ask you to 
send to us, or 3) if you don’t return the warranty registration card, 120 days after the date on 
which the Product was sold to the dealer from whom you bought the Product, as 
documented in our records. 
 
This warranty does not cover damage caused by: 1) handling during shipping, 2) use or 
maintenance contrary to labeled instructions, 3) alteration or repair by anyone not 
authorized by Welch Allyn, and 4) accidents. 
 
If a Product or accessory covered by this warranty is determined to be defective because of 
defective materials, components, or workmanship, and the warranty claim is made within 
the warranty period described above, Welch Allyn will, at its discretion, repair or replace the 
defective Product or accessory free of charge. 
 
You must obtain a return authorization from Welch Allyn to return your Product before you 
send it to Welch Allyn’s designated service center for repair.  
 
THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. WELCH ALLYN'S 
OBLIGATION UNDER THIS WARRANTY IS LIMITED TO REPAIR OR REPLACEMENT 
OF PRODUCTS CONTAINING A DEFECT. WELCH ALLYN IS NOT RESPONSIBLE FOR 
ANY INDIRECT OR CONSEQUENTIAL DAMAGES RESULTING FROM A PRODUCT 
DEFECT COVERED BY THE WARRANTY. 
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General information 

Welcome 
Welcome to the ABP module, the ambulatory blood pressure module of the Welch Allyn 
CardioPerfect Workstation. The ABP module allows the user to easily record, view and print 
24 hour ambulatory blood pressure tests. 
This manual contains specific information about the ABP module. These instructions must 
be studied before putting the unit into operation. For all general information about the 
workstation software please refer to the Workstation manual, this describes a.o.:  
- Creating and editing Patient cards 
- General information about printing 
 
For further information on installation and configuration please refer to the Workstation 
Installation and Configuration manual. 
 

Intended use 
The CardioPerfect Workstation (CPWS) software with associated accessories is indicated 
for the acquisition, analysis, formatting, display, printing and storage of certain physiologic 
signals, for the purpose of assisting the clinician in the diagnosis and monitoring of various 
diseases and/or treatment regimens. Using the optional ambulatory blood pressure (ABP) 
module of the Welch Allyn CardioPerfect Workstation (and associated accessories), the 
user can easily acquire, record retrieve, view and print 24 hour ambulatory blood pressure 
tests using the ABP recorder. 
The ABP recorder is an automated, microprocessor controlled blood pressure monitor, 
which monitors, accumulates and stores heart beat (rate), systolic and diastolic data of an 
individual adult or pediatric patient (in the patient’s environment) for a session which may 
last for up to 250 measurements. 
 

Indications  
Possible clinical indications for ambulatory blood pressure measurement:  
 
- Suspected white coat hypertension  
- Suspected nocturnal hypertension 
- To establish dipper status 
- Resistant hypertension 
- Elderly patient 
- As a guide to antihypertensive drug treatment 
- Type 1 diabetes 
- Evaluations of hypotension 
- Autonomic failure 
- Masked hypertension 
 
Because of the widespread availability and application of the generic kind of device, the 
customer is assumed knowledgeable enough to determine if use of the device is indicated. 
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Contraindications and considerations 
Some patients find the cuff pressure intolerable, particularly those with very high blood 
pressure and who have frequent repeat readings. ABPM is uncommonly associated with 
any complications. Petechiae of the upper arm and sometimes bruising under the inflating 
cuff may occur, and sleep disturbance is fairly common. In general, ABP may not be 
accurate during exercise or when driving, or when the cardiac rate is irregular, as in atrial 
fibrillation. There may be technical reasons why ambulatory readings fail in some patients 
(e.g. problems with cuff fitting in patients with conical-shaped arms, movement artefact, 
tremor, weak or irregular pulse, auscultatory gap). [The Medical Journal of Australia 2002, 
176(12), p. 588-592, Barry P McGrath] 
 
Note: for recorder specific information please refer to the appropriate hardware manual. 
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1. Getting started 
 

1.1  The ABP window 
The ABP window is the central part of the ABP module.  
 
 
 
 

  

 
 
Title bar  The title bar displays the name of the program. The title bar contains three 

buttons that you can use to maximize, minimize and close the ABP 
window. 

 
Menu bar  Each menu in the menu bar contains a number of tasks that you can 

perform with the ABP module. Sometimes, menus are gray. This means 
that you cannot access that functionality at that particular point, either 
because it is not available, or because you are not authorized to use it.  

 
Tool bar  The tool bar contains buttons that give you easy access to the most 

common tasks in ABP, such as recording and printing a test, reading back 
the measurements, interpretation and test information.  

 
Search area  The search area on the left hand side contains search and display 

functionality that lets you easily retrieve patients and tests. In the search 
area, you can find a patient, see which tests were recorded for that patient 
and see the kind of tests that were recorded. You can also create search 
patterns, an easy way of finding information that you need frequently.  

 

Title bar Menu bar Search 
area 

Toolbar 

Workspace 

Status bar 
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Workspace  The workspace displays tests and test related data, such as 
interpretations, measurements and comments. This is where you will do 
the actual recording, viewing and interpretation. The ABP workspace 
contains a viewing area with a number of tabs that let you see different 
aspects of the test. The tabs, also called views, that are available are: 
Measurements, Hourly intervals, Trends, Summary, Scatter points, Rise 
and fall and Exceeding norms. 

 
Shortcut menu In the workspace, you can use a shortcut menu to access the most 

common tasks. You can access these tasks by clicking on the workspace 
with your right mouse button.  

 
Status bar  The status bar at the bottom of the window shows the current user. 
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2. Recording an ABP test 

2.1  About recording ABP tests 
An ambulatory blood pressure test consists of two parts: 
• Starting a test and preparing the ABP recorder for use. 
• Reading back the recorded measurements to the computer. 
 
For both parts, the ABP recorder needs to be connected to the computer. Please refer to 
the ABPM 6100 hardware manual for instructions on how to handle and maintain the ABPM 
6100 recorder. 
  

2.2  Record an ABP test 
Follow these global steps. Each step is explained in more detail on the following pages. 
 
To record an ABP test: 

1. Connect the blood pressure recorder to your computer. 

2. Select a patient, or create a new one. 

3. In the File menu, point to New, and click Ambulatory blood pressure. The ABP 
module starts to communicate with the ABP recorder.  

4. If two devices are connected select which device should be used for the recording 
in the window that pops up. 

 
5. If the Name new device dialog box is displayed, enter the name of the blood 

pressure recorder. 
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6. After this step, a number of situations can occur: 

If the recorder... Continue with... 
Is empty Enter patient and protocol information 
Does contain measurements from 
previous tests. 

Store previously recorded measurements.  
Enter patient and protocol information 

7. Disconnect the blood pressure recorder from your computer and place it in the 
pouch. The patient wears the recorder for 24 hours. 

8. When the patient returns, connect the blood pressure recorder to the computer 
again, and read back the measurements.  

 

Enter patient and protocol information 
Before you can record an ABP test, you first need to enter patient and protocol information. 
This information is saved together with the recording.  
 
You can enter patient and protocol information in the New Ambulatory Blood Pressure 
Test dialog box. This dialog box is displayed: 

- Immediately when you start a new test with an empty ABP recorder. 

- After deleting the measurements when you start a new test with an ABP recorder that 
was not empty. 

 

 
 
To enter patient and protocol information: 

1. From the Specialty list, select the specialty of the physician that ordered the test. 

2. From the Referring physician list, select the name of the physician that ordered the 
test. 

3. From the Protocol list, select the protocol that you want to use for the test. 

4. Click OK. The ABP module shows that the test is in progress.  
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Please refer to chapter 6.5  and 6.6  for more information on protocols and the protocol 
editor. 
 

 

Store previously recorded measurements 
The recorder can contain measurements from previously recorded tests. You can choose to 
save those measurements to the database before deleting them from the recorder. 
How the measurements are saved depends on the patient for which the measurements 
were recorded. 
 

If the measurements belong to... Then you can... 
The current patient Read back the measurements and save them to 

the patient's test in progress. 
Another patient Assign the measurements to a test in progress for 

that patient. 
An unknown patient Create a new patient and assign the 

measurements to the new test for that patient. 
  
 
To read back the measurements and save them to the patient's previous test: 

1. If you try to record a test for a patient who already has a test in progress, the following 
message is displayed:  

 
2. Click Yes. The measurements are read from the ABP recorder and saved to the 

patient's previous test. 

Note: if you click No, you cannot start a new test for the current patient, because a 
patient can only have one test in progress. 

  
To assign the measurements to a test of another patient: 

1. If you want to record a test for the current patient, but the ABP recorder still contains 
measurements of another patient, the following message is displayed:  
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2. Click Yes. The measurements are assigned to the patient that is mentioned in the 
message. The New ambulatory blood pressure test dialog box is displayed, so that 
you can continue with recording a test for the current patient. 

Note: if you click No, the measurements are deleted from the ABP recorder without 
being saved. 

  
To assign the measurements to a new patient: 

1. If you want to record a test for the current patient, but the ABP recorder still contains 
measurements of an unknown patient, the following message is displayed:  

 
2. Click Yes. A new patient card is created. This card only contains a patient number. The 

New ambulatory blood pressure test dialog box is displayed, so that you can 
continue with recording a test for the current patient. 

Note: if you click No, the measurements are deleted from the ABP recorder without 
being saved. 

 

2.3  Read back measurements 
When the patient has returned, you need to read back the measurements and transfer them 
to the computer. Once you have transferred the measurements to the computer, you can 
view them in the ABP module. 
 
To read back the measurements and save them on your computer: 

1. Connect the ABP recorder to your computer. The In progress dialog is displayed. 

2. Press the Read measurements button. The Ambulatory Blood Pressure 
Measurements read back dialog box is displayed.  
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3. This dialog box displays the specialty and the name of the referring physician that 

ordered the test. In addition, it shows: 
• The period that the patient was asleep. 
• The number of measurements or events that were recorded. 

 
4. The sleeping period is set to the default settings that were entered in the ABP settings. 

You can change the values to that they reflect the patient's actual sleeping period. 
 
5. Decide whether you want to delete the measurements from the ABP recorder. If you 

want to delete the measurements, select the option at the bottom of the dialog box.  
 
6. Press OK to transfer the measurements to the computer and save them with the patient 

that is mentioned at the top of the dialog box. 
 

• Note: if you click the Cancel button, the measurements are not transferred to the 
computer. The test remains in progress. 

  

Tips for reading back measurements: 
• You can also read back the measurements by clicking the Read back button on the 

toolbar, if the ABP module is activated. This way, you do not need to select the patient 
before reading back the measurements, which speeds up the reading back process. 
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3. Viewing an ABP test 

3.1  View an ABP test 

To view an ABP test: 

1. In the patient list, select the patient whose test you want to view. The tests that 
have been recorded for that patient are listed in the test list. 

2. From the test list, select the ABP test that you want to see. ABP tests are indicated 
with . The ABP module is started automatically, and the test is displayed in the 
workspace. 

 

3.2  View and add information 
You can view information that was entered when the test was recorded. Additionally, you 
can add your own comments. 
To view information about the test: 

• In the Tools menu, click Information. The Information dialog box is displayed. 
 

 

To enter your own comments: 
• In the Comment section of the Information dialog box, start typing and click OK. 

 

3.3  Views 
With the ABP module, you can view ABP test results in seven different views: 
• Measurements and events 
• Hourly intervals 
• Trends 
• Summary 
• Scatter points 
• Rise and fall 
• Exceeding norms 
• Frequency distribution 
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3.4  Measurements view 
The Measurements view displays a list of measurements and events. Measurements are 
automatically made by the ABP recorder. Events are created when the patient presses the 
button on the recorder. 
 

 
 
Information 
For each measurement, the following information is presented: 

• Number, date and time of the recording. 
• Systolic and diastolic pressure. 
• Mean arterial pressure (MAP) 
• Heart rate 
• Pulse pressure 
• Rate pressure product (RPP= systolic pressure * heart rate)  
• Comment 

 
Norm values 

Values that are above the norm values are displayed in bold red text.  
 
Sleeping period 

Measurements that were recorded when the patient was asleep are displayed in the 
grayed area of the view. 

 
 

Working with the Measurements view 
In the Measurements view, you can: 
• Assign measurements to the sleeping or waking period 
• Add a comment to a measurement 
• Temporarily hide a measurement from a test 
• Delete a measurement 
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Assign measurements to the waking or sleeping period 
The measurements in an ABP test are divided into two categories: 
• Measurements that were taken when the patient was awake (waking period). 
• Measurements that were taken when the patient was asleep (sleeping period). 
 
This is done according to the default ABP settings. Usually this division consists of an 8-
hour night and a 16-hour day. When you read back the measurements, you can change the 
sleeping period values so that they reflect the patient's actual sleeping period. 
 
You can change the period to which a measurement was assigned. This can be necessary, 
for instance when the patient has not slept very well and decided to read a book. He might 
also have decided to sleep in. 
 
To assign a measurement from the sleeping period to the waking period: 

1. Right click on the measurement that you want to assign to the waking period. 

2. In the shortcut menu, click Set awake. The gray shade is removed from theme 
asurement to indicate that the patient was awake when this measurement was taken. 

To assign measurements from the waking period to the sleeping period: 

1. Right click on the measurement that you want to assign to the sleeping period. 

2. In the shortcut menu, click Set asleep. A gray shade is added to the measurement to 
indicate that the patient was asleep when this measurement was taken. 

 

Add a comment 
When you want to make note of something in a measurement, you can add a comment to 
that measurement.  
 
To add a comment: 

1. In the Measurements view, click on Comment field of the measurement to which you 
want to add the comment. The field becomes active, and a pointer appears, click again 
on the field and a cursor appears. 

2. Enter your comment. The comment is automatically saved with the test. 

 

Temporarily hide a measurement from a test 
When you do not want to view a measurement, but do not want to delete it from the test 
either, you can temporarily hide it.  
 

To temporarily hide a measurement: 

1. In the Measurements view, click the measurement that you want to hide. 

2. Right click on the measurement. In the shortcut menu, click Exclude. The measurement 
number is put between brackets to indicate that this measurement is not used in the 
test at the moment. The measurement is not used in any of the measurements or 
graphs in the other views. 
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3. Click Include to make the measurement part of the test again. 
 

Delete a measurement 
When a measurement or event is not valid, you can delete it from the test. 
 
To delete a measurement: 

1. In the Measurements view, right click on the measurement. 

2. In the shortcut menu, click Delete. The measurement is deleted from the test. It is not 
used in any of the views any longer. 

 

3.5  Hourly intervals view 
The Hourly intervals view displays the average of a number of values and their 
corresponding standard deviations at intervals of 1, 2, 3, 4, 6 or 8 hours. 
 

 
 
Information 
The averages of the following values are displayed: 
• Systolic pressure 
• Diastolic pressure 
• Heart rate 

Working with the Hourly intervals view 
In the Hourly intervals view, you can change the intervals for which the values are 
displayed. 
 
To change the intervals for which the values are displayed: 
• Click on one of the interval buttons at the top of the Hourly interval view. The interval is 

changed. 
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3.6  Trends view 
The Trends view shows a graphical representation of the ABP test.  
 

 
 
Information 

• The upper chart displays the systolic pressure, MAP (when selected) and diastolic 
pressure 

• The lower chart displays the heart rate 
 
Norm values 

Upper and lower norm values are displayed in dotted lines. 
 
Sleeping period 

Measurements that were recorded when the patient was asleep are displayed in the 
grayed area of the view. 

 

Working with the trends view 
In the Trends view, you can: 

• View the exact values with the measurement slider 
• Compare ABP tests  
• Zoom in on parts of the trends graph (see §3.10 ) 
 

View exact values in the Trends view 
The Trends view displays information in a graph. You can see the exact values of a point in 
the graph with the measurements slider. This is a vertical line that you can slide over the 
graph. The exact values for the points in the graph are displayed on the right hand side of 
the Trends view. 
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The measurements slider only gives exact values for 30 minutes intervals.  

 

Compare ABP tests of the same patient 
In the Trends view, you can compare the current ABP record with a previous recorded test 
of the same patient. 
 

 

 
To make a comparison: 

Exact value for points 
at slider position 

Slider 

1. Right click on the graph. 

2. In the shortcut menu, click Comparison. 

 

3. In the Comparison dialog box select the test with which you want to compare 
the current test and click OK. 

4. The graphs for both tests are shown in the Trends view window. To return to 
the current test, click Comparison in the shortcut menu and click on the 
selected test. 
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3.7  Summary view 
The Summary view displays statistics for general information, systolic pressure, diastolic 
pressure and heart rate. For each of the statistics, the values are given for the waking 
period, the sleeping period and the entire test. 

 
 
Information 

The general statistics consist of: 
• Number of measurements 
• Total recording time 
• Average blood pressure 
• Standard deviation of the blood pressure 
• Average pulse pressure 

 
The systolic and diastolic pressure statistics consist of: 

• Number of measurements that is greater than or equal to the norm value that is 
displayed in the field. 

• Minimum value that was measured 
• Maximum value that was measured 

 
The heart rate statistics consist of: 

• Average 
• Standard deviation 
• Minimum heart rate that was measured 
• Maximum heart rate that was measured 

 
Awake/asleep decrease 

The decrease in blood pressure in the sleeping period compared to the blood 
pressure in the awake period is expressed in the decrease percentages at the 
bottom of the view. 

 
Morning average 

The average blood pressure in the first hour after the sleep period is expressed in 
the morning average at the bottom of the view. 
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Working with the summary view 
In the Summary view, you can: 
• Change the norm values for the systolic and diastolic blood pressure, and see how 

many measurements are above the norm value. 
 

Change the norm values  
The Summary view displays how many measurements are greater than or equal to the 
norm values. The norm values are set as a default in the ABP module. You can change the 
norm values for one test. 
 
To change the norm values: 
In the Summary view, enter a new norm value in one of the norm value fields. 

 
 
  

3.8  Scatter points view 
A scatter plot reveals relationships or association between two variables. Such relationships 
manifest themselves by any non-random structure in the plot. 
 
The Scatter points view displays the correlation between the following values: 
• Systolic pressure against heart rate 
• Diastolic pressure against heart rate 
• MAP against heart rate 
• Systolic pressure against diastolic pressure 

 

 
 
Information 

One point on a graph represents one measurement. Black points were measured 
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during the sleeping period. 
 
Sleeping period 

Each correlation graph can be displayed for all measurements, measurements for the 
sleeping period or measurements for the awake period. 

 

Working with the Scatter points view 
In the Scatter points view, you can: 

• Toggle between one graph or all graphs. 
• Zoom in on a graph (see §3.10 ). 

 

Toggle between one or all graphs 
In the Scatter point view, the default view displays all four scatter point graphs. You can 
display each graph individually by clicking the graph names at the top of the Scatter point 
view.  
 

 
 
You can also select whether you want to see the overall measurements, measurements for 
the sleeping period or measurements for the waking period. 
 

3.9  Rise and fall view 
The Rise and fall view displays values for the rise and fall of the blood pressure during the 
test. 

 
 
Information 

The upper chart displays: 
• The diastolic and systolic pressure and MAP values. 
• A rise and fall curve. This curve is obtained by filtering the MAP curve. 
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The lower chart displays: 
• A first derivation of the filtered MAP curve. This derivation clearly displays the 

rise and fall of the blood pressure. 
 

Sleeping period 
The measurements that were recorded during the sleeping period are displayed in 
the grayed area. 

 

Working with the Rise and fall view 
In the Rise and fall view, you can: 
• Zoom in on a graph (see §3.10 ). 
 

3.10  Zoom in on a graph 
In the Trends view, the Scatter points view and the Rise and fall view, you can zoom in 
on a part of the graph. 
 
To zoom in on a graph: 

1. Position your mouse near the area that you want to enlarge. 

2. Click your mouse button and keep it pressed. When you move the mouse from the 
top left corner to the bottom right corner of the graph, a square is drawn.  

 
3. Drag the square over the area that you want to enlarge. The area is enlarged. 

  
To reset the zoom: 

1. Right click on the graph. 

2. In the shortcut menu, click Reset zoom. The graph is restored to its original size. 

 

3.11  Exceeding norms view 
The Exceeding norms view displays the percentages of measurements that are 
• Normal (less or equal than the norm value) 
• Acceptable (range [100 – 125] % of the norm value)  
• Critical (greater than 125% of the norm value) 
 
See paragraph 6.2  ‘ABP settings- General tab’ on page 30 for the norm value. 
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The percentages are displayed in pie charts, both for systolic and diastolic pressure. 

 
   

3.12  Frequency distribution 
In the Frequency distribution window the frequencies of the systolic and diastolic pressure 
are shown divided in 10 mmHg bins. The Heart rate frequencies are shown divided in 10 
bpm bins. 

 
 
You can select whether you want to see the overall graphic, the graphic for the sleeping or 
the waking period and select which percentage is shown. 
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4. Interpreting an ABP test 
   

4.1  Edit and confirm an interpretation 
You can edit an interpretation in the Interpretation editor. In this editor, you can enter your 
own texts. Alternatively, you can use the statement tree to select and enter common 
interpretation statements. Once you edit an interpretation, you must confirm it. Otherwise, 
your changes will not be saved. 

 
To edit and confirm an interpretation manually: 

1. In the Tools menu, click Interpretation. The Interpretation editor is displayed. 

 
2. In the right hand pane, at the pointer, start typing. 

3. Click the Confirm button to save your comments and to return to the ABP test. 
  
 
To edit and confirm an interpretation with the statement tree: 

1. In the Tools menu, click Interpretation. The Interpretation editor is displayed. 

2. From the statement tree, click on one of the categories to display all possible 
statements for that category. 

3. From a category, click on the statement that you want to include in the 
interpretation. The statement is added.  

4. To delete a statement from the interpretation, select the statement text and press 
BACKSPACE to delete it. 

5. Click the Confirm button to save your comments and to return to the ABP test. 
  
Tips for editing and confirming an interpretation: 

• You can automatically insert the current date and time by clicking the Date/time button.  

• You can clear the interpretation editor by clicking the Clear button. 
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4.2  View interpretation history 
When you change something in an interpretation, the ABP module does not change the 
original interpretation, but creates a new one. This way, you never loose any information. A 
copy of all interpretations is kept in the interpretation history. 

 
To view the interpretation history: 

1. In the Tools menu, click History. The Interpretation history window is displayed.  

 
2. The left hand pane displays the interpretations sorted by date. The right hand pane 

shows the content of each interpretation, plus the interpretation date, time and editor. 

3. Click on a date to view an interpretation.  
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5. Printing an ABP test 
 

5.1  About printing ABP tests 
With the ABP module, you can print ABP tests on plain paper with an regular inkjet or laser 
printer. You can choose from a number of formats in which you want to print the 
information. Each print format has a header that contains additional information. With the 
Print preview function, you can see what a printed ABP test will look like on paper. 
 

Print formats 
The ABP module can print the following formats: 
• Trends 
• Summary 
• Scatter points 
• Scatter points awake 
• Scatter points asleep 
• Rise and fall 
• Measurements 
• Hourly intervals 
• Hourly intervals with an interval of 2, 3, 4, 6 or 8 hours 
• Frequency distributions 
• Frequency distributions asleep or awake 
• Exceeding norms 
 
Each format contains the view and a header that displays additional information. 
You can print several formats at the same time.  
 
If among others the Summary report is selected in the default report templates in the ABP 
printing settings tab, the summary report will be printed first. 
 

Please refer to the Workstation manual for further information on printing tests. 
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6. Customize the ABP module 

6.1  About customizing  
You can adjust various ABP settings to your own needs and wishes. You can, for example, 
change the norm values for diastolic and systolic pressure, set the dipping percentage or 
select the formats that you want to use with the Print selected formats function. 
 
The features that you can customize are located in the ABP settings. 
 

To open the ABP settings: 
1. In the File menu, click Settings. The Settings dialog box is displayed. 
2. Click Ambulatory Blood Pressure. 
 
Protocols To add and edit protocols, use the Protocol editor. 

 

6.2  ABP settings- General tab 
Use the General tab to customize the norm values, default sleeping time and dipping 
definitions. 
 
The General tab contains the following information: 
 
Norm values The norm values that are used by the ABP module to compare 

measurements. You can set norm values for diastolic and systolic 
pressure, for both sleeping and waking periods. 
 

Default sleeping 
time 

The period that is used as the default sleeping time. You can always 
manually assign measurements to sleeping and waking time. 
 

Dipping The percentage at which the blood pressure dips 
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6.3  ABP settings- Printing tab 
Use the Printing tab to select the formats that you want to use for the Print selected 
formats function. 
 
The Printing tab contains the following information: 

 
Default report templates     
Here, you can select the formats that you want to print when you use the Print selected 
formats function. You can select multiple formats. 
 
Print after the measurements are read back from the device 
If selected the ABP test is automatically printed when the measurements are read back 
from the device. The formats that are selected in the Default report templates area are 
printed.  

 

6.4  ABP settings- Advanced tab 
Use the Advanced tab to select the Recording device and the COM port for the ABP 
recorder.  

 
 
 
The Advanced tab contains the following information: 
 
Recording device Enable the ABPM 6100, the ABP Perfect or both. If you have 

selected both a window will pop up when you want to make a new 
recording in which you can select which device to use. 
 

Connected to From this list, you can select the port to which the ABP recorder is 
connected. 
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Use safe 
initialization 

Use this option if the ABP Perfect recorder has problem 
communicating with the ABP program.  
 

Max. inflation 
pressure 

Allows you to select the maximum pressure that the unit will inflate 
the cuff to in mmHG 

Enable start button If selected a measurement can be manually started with the start 
button. If not, this can only be done in the first 30 minutes. 

Auto erase When you select this option, the measurements are automatically 
erased from the device after storing them into the database. 

 

6.5  Protocols  
A protocol is an important part of the ABP module. It contains information about when the 
ABP recorder must record a measurement.  
 
A protocol contains a number of stages. Each stage contains the following information: 

• Start time: the time the stage becomes active. 

• Time interval: time in minutes between two measurements. 

• Number of measurements: number of measurements that are recorded per hour 
during this stage. You can select 0, 1, 2, 3, 4, 5, 6, 10, 12, 15, 20 or 30 measurements 
per hour. If you set the number of measurements to 6, this means that a measurement 
will be recorded every 10 minutes. 

• Buzzer: whether the buzzer should play a sound when a recording is made. This way, 
the patient can prepare himself and reduce the possibility of an error measurement. If 
an error measurement occurs, a repeated measurement is taken at exactly 3 minutes 
after the error measurement. 

 
You can add and edit protocols in the Protocol editor. 
 
Note: 

The ABPM 6100 only supports 0, 1, 2, 3, 4, 6 or 12 measurements per hour. If the 
ABPM 6100 is selected and an unsupported measurement is used, a warning dialog 
will appear. If you select cancel a new measurement per hour can be selected. If you 
select ignore, the measurement will be listed however this protocol cannot be used 
with the ABPM 6100. 
The maximum number of protocol entries is limited to 6. If either the maximum number 
of entries is exceeded or an unsupported entry has been inserted the ABPM 6100 
refuses to upload. 
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6.6  Add or edit a protocol 
With the protocol editor, you can add new protocols or edit existing ones. Adding a 
protocol consists of two parts:  
 
• Creating the protocol 
• Adding stages to the protocol. 
  

Note: 
The ABPM 6100 only supports 0, 1, 2, 3, 4, 6 or 12 measurements per hour. 

 
To create a new protocol: 

1. In the Tools menu, click Protocol editor. The Protocol editor is started. 

 
Device selection box 

 

 
Stages list  Protocol tree 

 

2. Select in the Device selection box, which type of protocol you want to create. Either 
a protocol for the ABPM 6100 or for the ABP Perfect or for both. 

3. Right click on the Protocol tree. 

4. In the shortcut menu, click New. A new empty protocol is added to the Protocol 
tree. 

5. Enter a meaningful name for the new protocol. 
  
To add a stage to the protocol: 

1. Right click in the stages list. 

2. In the shortcut menu, click New. The Time interval editor is started. 

3. Enter the time at which the stage must start. 

4. Enter the number of measurements that must be made per hour. 

5. If you want the buzzer to play a sound before recording, select the Buzzer option. 

6. If you want the measurement to be displayed on the ABP recorder right after it was 
recorded, select the Show measurements on device option. 
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To edit a stage: 

1. In the stages list, double click on the stage that you want to edit. The Time interval 
editor is started. 

2. Change the information  

 

6.7  Customize abp.txt 
You can customize the statements that are used in the Interpretation editor according to 
your own preferences.  
To customize the statements: 

1. Use Notepad to open the file abp.txt. As a default, this file is located in C:\program 
files\cardio control\mdw\modules\resources\0009 (English) or \0013 (Dutch).  

2. Edit, add and delete the statements according to your own preferences. 

 
 
Abp.txt consists of statements that are grouped in categories. The statements are listed 
under the category name they belong to. Statements indent one position. 
 

To create a new category: 

1. Type the name of the new category on the first position of a new line. 

2. Enter the statements you want to add to this category on new lines, make sure that 
each statement indents one character. 

 

 
6.8  Device overview 
The device overview displays the ABP devices that are currently in use, the patients to 
whom they are assigned and the times when recordings have started. 
To view the Device overview: 

• In the Tools menu, click Device overview. The Device overview is displayed. 

 

6.9  ABP error list 
In the error list you can see the errors that can occur during the test recording as shown by 
the software.  
 
The error list dialog consists of two items: 

• Number of the error 
• Explanation  

 
An error can occur because of a number of reasons. Most of the reasons are listed in the 
explanations. 
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Error  Description 

1  Unknown error 
2  This can indicate one of the following problems: 

• After 2 seconds the pulse has not reached the falling level. 
• Heart frequency has not reached its defined range. 
• Variation of the heart frequency is too large. 
• Less than 4 measurements were taken. 
• The rising level was not reached within 2 seconds after the falling level. 
• Pulse bandwidth is out of range. 
• Movement artefact. 
• Maximum number of beats encountered in a stage. 

3  • This can indicate one of the following problems: 
• The heart frequency was out of range in more than 3 pressure stages. 
• The difference between systole and diastole was too small. 
• The systole is considerably bigger than the pump pressure. 
• An oscillation value was smaller than the start or end value. 
• The pulse bandwidth is smaller than at start or end point. 
• The MAP is out of range. 
• The systole is out of range. 
• The diastole is too large. 
• The number of stages is too large. 
• The oscillation value is too large. 
• The total time is too long. 
• A function took too much time. 

4  The battery voltage is too low.  
5  No cuff was detected. 
6  Too many measurements were taken  

-or- 
No memory was available in EEPROM  

7  No measurements are available. 
-or-  
The measurements were stopped. 

8  Hardware failure 
-or-  
Error at zero alignment or pumping started unexpectedly. 

 
Note: The codes mentioned above are the codes as listed by the software. The can differ 
from the codes in the LCD display of the ABPM 6100. The latter ones are for reference 
only, the error codes used in the software module as listed above are the error codes which 
correctly identify the possible error status. 



 
CardioPerfect Workstation
ABP Module - User Manual 

 
 

DIR 80012332 Ver. B  36 / 40 
 

7. Troubleshooting 
  
When creating a new ABP test, the computer tells me that there is no response from 
the hardware: 

• Check if there are fresh batteries in the device 
• Check if the device is connected to the COM port of the computer 
• Check if the COM-port settings in the CPWS settings menu correspond with the 

actually used COM port 
While using the ABP Perfect:  
• Check if “co” is displayed on the display of the ABP Perfect (see below for further 

checking) 
• Try switching on “Use safe initialization” in the advanced part of the ABP settings 

menu  
 
 
The ABP Perfect unit does not display “co” after it has been connected to the 
computer: 

• Check if there are fresh batteries in the device 
• Switch the device off and on once more to make sure the device was switched on 

after the device has been connected to the computer 
 
Measurement fails repeatedly: 

• Make sure the chosen cuff fits the patients arm correctly 
• Check if the cuff is (still) positioned correctly 
• Try a measurement with the cuff on the other arm 
• If the pump does not seem to work, try again with fresh batteries 
• To determine whether the device works at all, try a measurement on a (test) person 

who has been successfully tested before. 
 
An error code appears on the display of the ABP unit: 

• See the list of possible errors in the CPWS help-file and on page 34. 
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8. Installing the ABP module 
The Welch Allyn Cardio Perfect ABP software module can be used with the following 
devices: 
 

• Mobil-O-Graph ABP Perfect: 
OEM ABP Monitor: I.E.M. GmbH, Stolberg, Germany, Mobil-o-Graph    

 
 

 0434 
 

• ABPM 6100:  
WA ABP monitor: Welch Allyn, Inc.; Skaneateles Falls, NY, USA 

 
 

 0297 
 
  
The ABP module is made up of two elements: the recorder, and the software that runs on 
the computer to which the recorder is connected. Before you can start recording tests, you 
need to: 

• Connect the recorder to the computer. 
• Configure the software. 

 
Please refer to the ABPM 6100 hardware manual for instructions on how to handle and 
maintain the ABPM 6100 recorder. 
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8.1  Connect the recorder to the computer 

To connect the ABP Perfect recorder to the computer: 

1. Switch off the recorder. 

2. Connect the interface cable to the data connector of the recorder. Each time the 
cable from the data connector is connected or disconnected, the recorder must be 
switched off. 

3. Connect the serial connector of the interface cable to a free serial port or COM port 
on your computer. 

4. Switch on the recorder. 

5. The recorder is ready when its LCD display shows the word 'co'. 

 
To connect the ABPM 6100 recorder to the computer: 

1. Connect the interface cable to the data connector of the recorder. Each time the 
cable from the data connector is connected or disconnected, the recorder must be 
switched off. 

2. Connect the serial connector of the interface cable to a free serial port or COM port 
on your computer. 

3. Switch on the recorder. 
 

Note: Please refer to the ABPM Hardware Manual section 4. If your PC has no COM 
PORT. 

 

8.2  Configure Welch Allyn CardioPerfect Workstation 
After connecting the recorder, you need to configure Welch Allyn CardioPerfect 
Workstation.  
 
To configure Welch Allyn CardioPerfect Workstation for use with the recorder: 

1. Start Welch Allyn CardioPerfect Workstation. 

2. In the File menu, click Settings and click Ambulatory blood pressure. 

3. Click the Advanced tab. 

4. Select device. 

5. Set the COM-port number to the number of the serial port to which the ABP recorder is 
connected. 

6. Click OK to save the settings. 

 

 

For further information on installation and configuration please refer to the Workstation 
Installation and Configuration manual. 
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9. Function keys 
The Welch Allyn CardioPerfect module is, just like all Windows applications, designed for 
working with the mouse. However, there might be situations in which working with the 
keyboard can be quicker. Therefore a number of functions within the Welch Allyn 
CardioPerfect module can also be selected directly using the keyboard. Here is a list of all 
available keyboard shortcuts in this module, for a more general function key description 
please refer to the Workstation manual: 
 
 
 
 
ABP specific functions 
Key Function 
[SHIFT]+[CTRL]+[B] Starts a new ABP recording. 
F2 Start new test 
[CTRL]+[I] Opens the Interpretation window 
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